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1 System requirements 

1.1 CADbro System Requirements 

 

Operating System 

CADbro  

Microsoft® Windows 10  

Recommended system: Windows 10 Version 1909 or Windows 10 Version 20H2 

Tip: 

The 32-bit Windows operating system is not supported by CADbro since version CADbro 2023. 

Processor 

 

Intel Pentium ® 4(@2GHz or above), or equivalent AMD® processor , or equivalent AMD® processor 

GPU 

Support Microsoft DirectX® 9 and above or OpenGL 3.1 and above graphics cards 

Recommended configuration: NVIDIA GeForce GTX1050 Ti or NVIDIA GeFore GTX 1650 

RAM 

Minimum configuration: 2G 

Recommended configuration: 8G or above 

Virtual memory 

Minimum configuration: 1G 

Recommended configuration: 2G or above 

GB 

Minimum configuration: 4G free disc space 

Recommended configuration: 8G or above free disc space 

Video 

Minimum configuration: 1024 x 768 VGA with True Color 

Recommended configuration: 1280×1024,1680×1050,1920×1080 VGA with True Color or above 

Pointing device 

 

Three-button mouse, trackall or other device. 

Required for 

licensing 

 

Soft Key 

Required for 

Floating License 
Installation of TCP/IP Network Protocol 

CD-ROM Any speed (for installation only) 
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1.2 Network License Manager System Requirements 

Operating System 

Minimum System Requirements： 

Microsoft® Windows Server 2008R2 and above 

Microsoft® Windows 7 

Microsoft® Windows 8 

Microsoft® Windows 10 

Microsoft® Windows 11 

Recommended System Requirements： 

Microsoft® Windows Server 2012 

Microsoft® Windows Server 2016 

Microsoft® Windows 7 

Microsoft® Windows 10 

Microsoft® Windows 11 

Processor 

Minimum configuration:  Intel® Pentium™ 4 1.5 GHz or equivalent AMD® processor 

Recommended configuration:  Intel® Core™2 Duo or AMD® Athlon™ X2 CPU or higher 

RAM 

Minimum configuration: 1G 

Recommended configuration: 2G or above 

Display card 

Minimum configuration: 128M 

Recommended configuration:  1 GB or more 

Hard disk 

Minimum configuration:  2 GB free space in OS disk, 1 GB free space in installation disk  

Recommended configuration:  4 GB free space in OS disk, 2 GB free space in installation disk 

Resolution 

Minimum configuration:  1024*768 VGA with True Color  

Recommended configuration:  1440*900 with NVIDIA 8 series or AMD Radeon HD series or higher 

Pointing device 
Mouse, trackball, or other devices 

DVD-ROM Any speed (for installation only) 
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2 Softkey activate 

2.1 Stand-alone Version 

2.1.1 Activation 

If you wish to operate CADbro with full functions, it must be activated. Activation needs a soft 

key, if you do not have a Soft Key, please contact the local dealer from whom you purchased 

CADbro. 

Please follow these steps to activate CADbro online: 

1. On the desktop, double-click the CADbro 20XX icon.

2. You can see the activate interface.

file:///C:/Users/Administrator/AppData/Roaming/Microsoft/Word/CADbro%20install/CHM/Eng/articles_registration/install-3.html
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3. Enter the Activation ID (Soft Key) in the text box and press the Verify button. If the 

Activation ID is used the first time, the user needs to enter your information. Click 

Activate. The activation will be successful after a few seconds. 

 

4. Click OK to close the successful activation message, and back to the license manager. 

 
5. Click Ok to close the license manager dialog box, and CADbro will be restarted to get the 

license. 
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In the case of no Internet connection on the local computer, you can activate CADbro through 

procedures illustrated as follows: 

1. On the desktop, double-click the CADbro 20XX icon. 

 
2. In the Online Activation dialog box, click the click here to go to offline activation dialog.   
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3. In the Offline Activation dialog box, fill in the Activation ID (Soft Key) and Generate a 

Request XML File. Save the file onto the local computer. 
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4. Go to another computer with an Internet connection and use the Request XML File to 

obtain a corresponding Response XML File via E-mail or Online Self-Service 

a) Option 1: E-mail 

You may send the generated Request XML File to the ZWSOFT License Center at 

register@zwcad.com. The ZWSOFT License Center will send you the corresponding 

Response XML File as soon as possible. 

b)  Option 2: Online Self-Service: 

(1)  Go to the ZWSOFT License Center at 

http://license.zwsoft.com/zw3dCustomer.aspx and Login with the Activation 

ID (Soft Key). 

 
(2) Choose Activate or Manage Entitlements, and then click Manual Activation. 

 

mailto:register@zwcad.com,ZWCAD
mailto:register@zwcad.com
mailto:register@zwcad.com,ZWCAD
http://license.zwsoft.com/zw3dCustomer.aspx
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(3) Click Browse to import your Request XML File, and then click Submit. 

 
 

(4) Then you will be able to see the information of the corresponding Response 

XML File. Please save the file onto the local computer. 
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5. Click Browse to import the Response XML File, and then click Activate. The following 

message will be shown as follows after the successful activation. 

 

 

6. Click OK and back to the license manager. 
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7. Click Ok to close the license manager dialog box, and CADbro will be restarted to get the 

license. 
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2.1.2 Returning a License 

Please follow these steps to return CADbro License online: 

1. Launch License Manager as follows 

a. On the Windows taskbar, click the Start button. 

b. Choose All Programs (or Programs). (Operation system is win7 or win 8 need to choose 

ZWSOFT folder first). 

c. Choose CADbro20XX and then click the License Manager. 

2. Select the license to return, click Return.  

 

 

3. Click Online and the message will be shown. Read the message carefully. 
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4. Click OK to return, the license will be successfully returned in a few seconds. 

 
Please follow these steps to return CADbro License offline: 

1. Launch License Manager as follows 

a. On the Windows taskbar, click the Start button. 

b. Choose All Programs (or Programs). (Operation system is win7 or win 8 need to 

choose ZWSOFT folder first). 

c. Choose CADbro20XX, and then click License Manager. 
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2. Select the license to return, click Return. 

3. Click Offline and the message will be shown. Read the message carefully. 

 

 

4. Read the message carefully. Follow the steps described in the figure. 
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5. Press the Generate button to generate a Request XML File. Save the file onto the local 

computer. 
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6. Go to another computer with an Internet connection and use the Request XML File to 

obtain a corresponding Response XML File via E-mail or Online Self-Service 

a) Option 1: E-mail  

You may send the generated Request XML File to the ZWSOFT License Center at 

register@zwcad.com. The ZWSOFT License Center will send you the corresponding 

Response XML File as soon as possible. 

b) Option 2: Online Self-Service: 

(1) Go to the ZWSOFT License Center at 

http://support.zwcad.net:8888/flexnet/operationsportal/logon.do and Login with 

the Activation ID (Soft Key).  

 
(2) Choose Return or Manage Licenses, and then click Manual Return. 

 

(3) Click Browse to import your Request XML File, and then click Submit. 

mailto:register@zwcad.com,ZWCAD
mk:@MSITStore:D:/Program%20Files/zw3Deng/doc/ZW3D.CHM::/articles/s%22mailto:register@zwcad.com%22
mailto:register@zwcad.com,ZWCAD
http://support.zwcad.net:8888/flexnet/operationsportal/logon.do
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(4) Then you will be able to see the information of the corresponding Response XML 

File. Please save the file onto the local computer. 

 

7. Press the Return button to import the Response XML File, and then click OK. 
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 The following message will be shown as follows after the successful return, and the license 

is disabled in your current computer and available to be activated again.  
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2.2 Network Version 

2.2.1 Network License Manager Installation 

Please follow these steps to install the Network License Manager: 

1. Double-click the ZWSOFT_NetworkLicenseManager.exe to start the installation.

2. Do the following actions on the installation interface:

• Select the language version to be installed, click the language button to specify target

language from drop-down list;

• Specify the installation location for ZWSOFT Network License Manager. Use the

default path, or click Browse to choose another;

• Read the End User License Agreement carefully, and check Read and Accept.

3. Click Install Now to start installing.

4. The installation wizard prompts Installation Completed.
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5. Click Launch button to start Network License Manager; 

6. Click Done button to close installation wizard. 

TIPS 

 

:If a low-version network license manager is installed, you will be reminded whether to update 

the product. 

 

2.2.2 Activating License Server 

Activate the License Server by Network License Manager. Please follow these steps to active 

the License Server: 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open the ZWSOFT Network License Manager page. 

2. Click Activate License to enter the Activate License page. 

You can switch list mode or chart mode through the button in upper right corner. 
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3. Choose one of the activation type below. 

• Online Activation 

• Offline Activation 

2.2.2.1 Online Activation 

If you have access to Internet, you can directly send the Activation ID to ZWSOFT Products 

Authorized Server to activate the license server. This is the most continent way for activation. 

STEPS: 

1. Input your Activation ID and License quantity on Online Activation page, and then click 

Activate to activate the product. 

mk:@MSITStore:C:/Users/Administrator/Documents/WXWork/1688850548317080/Cache/File/2022-07/ZWSOFT%20NLM%20Help(1).chm::/LicenseGuide/html/TS03010101.htm
mk:@MSITStore:C:/Users/Administrator/Documents/WXWork/1688850548317080/Cache/File/2022-07/ZWSOFT%20NLM%20Help(1).chm::/LicenseGuide/html/TS03010102.htm
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2. After successful activation, the following prompt is displayed. Click Done to return to the 

home page of ZWSOFT Network License Manager. Otherwise, you can contact with 

ZWSoft Registration Center. 

 

 

2.2.2.2 Offline Activation 

If there's no Internet, you can generate an activation request file by activating with Activation 

ID, send the request file to ZWSoft Registration Center, or login onto ZWSOFT Products Self-

Service Activation Platform to get the activation file, and then activate license server by the 
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response file. 

STEPS: 

1. Input your Activation ID and License quantity on Offline Activation page. Click Generate, 

and then specify a path that you want to save the activation request file in the pop-up 

Save as dialog box. 

 

2. Login http://support.zwcad.net:8888/flexnet/operationsportal to obtain a response file. 

(1) Select With Activation ID, input your activation ID, select a language and then click 

Login. 

(2) Click Manage Entitlements. 

(3) Select the wanted product, and then click Manual Activation. 

(4) Click Locate to import the activation request file generated on Step 1 and then click 

Submit. 

(5) Save your response file by clicking Save To File, and then exit the ZWSOFT Products 

Self-Service Activation Platform. 

3. Click Browse to import your response file obtained on Step 2 in the choose response file 

dialog box, and then click Activate to activate your product. 

http://support.zwcad.net:8888/flexnet/operationsportal
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4. After successful activation, the following prompt is displayed. Click Done to return to the 

home page of ZWSOFT Network License Manager. Otherwise, you can contact with 

ZWSoft Registration Center. 

 

 

2.2.2.3 Configuring License Server 

You should configure License Server so that you can distribute network licenses to workstations. 

At first, you need to determine which server model you want to use. 
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• Single license server mode 

The Network License Manager is installed on one server, so license management and 

activation is restricted to this server. 

Because all license management takes place on a single server, there is only one 

administration spot and one failure spot. However, if the single license server fails, ZWSOFT 

products cannot run until the server comes back to work again. 

The ZWSOFT Network License Manager will automatically set the configuration during 

installation, and you can confirm or set it through the Network License Configuration. 

STEPS: 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Configuration to open the ZWSOFT Network License Manager page. 

 NOTE 

If your ZWSOFT products server is installed on Microsoft Windows 7 and Microsoft 

Windows Vista, please use an administrator account to run it for the first time 

(Check Start → All Programs → ZWSOFT → ZWSOFT Network License Manager → 

Network License Configuration, right-click and then select Properties → 

Compatibilty → Check "Run as administrator"). Otherwise, the product cannot be 

activated normally. 

 NOTE 

Since version 11.14.1.3, both Windows xp and Windows 2003 are no longer 

supported by Network License Configuration(lmtools.exe). Check out the version of 

the application as follow: right click lmtools.exe file in the installation folder and 

select Properties in the context menu to open lmtools Properties dialog box, see 

File version in Details tab. 

2. Click the Service/License File tab. In this tab, the Configuration using Services and 

LMTOOLS ignores license file path environment variables options are checked by 

default. 

 

3. Click the Config Services tab to confirm the configuration. 
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Configuration instructions are as follows. 

• In the Service Name, you can set the service name to manage the license. The 

default service name is ZWSOFT Network License Manager. 

• In the Path to the lmgrd.exe file, specify the license manager daemon file 

(lmgrd.exe) path; You can enter it directly or click Browse to specify the file path (the 

default path is C:\Program Files\ZWSOFT\ZWSOFT Network License 

Manager\lmgrd.exe). 

• In the Path to the license file, specify the path of license file (LicenseFile.lic). You can 

enter it directly or click Browse to specify the file path (the default path is 

C:\Program Files\ZWSOFT\ZWSOFT Network License Manager\LicenseFile.lic). 

• In the Path to the debug log file, specify the path of debug log (LicenseFile.lic). You 

can enter it directly or click Browse to specify the file path (the default path is 

C:\ProgramData\ZWSOFT\ZWSOFT Network License Manager\License.log). 

 NOTE 

To avoid of a launch failure of Network License Manager, the recommended 

path of the log file is either the default path 

(C:\ProgramData\ZWSOFT\ZWSOFT Network License 

Manager\License.log) or the installation path(C:\Program 

Files\ZWSOFT\ZWSOFT 2022 Network License Manager(TS) 

ENU\sample.log). The log file name is editable. 

• Use Services is checked by default. 

• Start Server at Power Up is checked by default, and lmgrd.exe will be started 

automatically on system startup. 

• Click FlexNet Licensing Service Details to display the detailed version of FlexNet 

Publisher. 
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4. Click Save Service to save your configuration and click Yes to confirm your operation. 

NOTE 

If the log file is saved in the installation folder or in any other customized 

path, after clicking Yes, it will display a pop-up dialog box with the 

prompt "Windows preferred path <SystemDrive>\ProgramData to store 

service data is not set.". You can ignore this and continue saving the 

configurations by clicking OK. 

5. Choose Control Panel → Administrative Tools → Services, right click on the Name of the 

desired service, and selelct Properties in the context menu. 

 
6. Display ZWSOFT Network License Manager Properties dialog box, switch to Log On tab, 

click Local System account. 

 

 NOTE 
To avoid of a launch failure of Network License Manager, please do not 

omit step 5 and step 6. 

7. Go to Start/Stop/Reread page, click Start Server to start service, or click ReRead License 

File to refresh Network License Manager with your license file or optional file changes. 
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8. Close Network License Configuration (lmtools.exe). 

 

2.2.3 Returning Network License 

This feature is used for license transferring and product upgrading. If you want to transfer the 

license from the original computer to another one or upgrade your products under the 

condition that some licenses have been activated, the license from the original computer must 

be returned first before re-obtaining the authorization. 

2.2.3.1 Stop License Server 

Make sure to login with administrator to use the Network License Configuration. 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Configuration. 

2. Choose Configuration using Services from the Service/License File tab of Network 

License Configuration, and select the service name of the license server you want to stop 

manually. 

 
3. Switch to Start/Stop/Reread tab and click Stop Server to stop the license server. 
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4. Shut down Network License Configuration. 

 

2.2.3.2 Online Return 

Return the license to "ZESOFT Products Platform License Server" directly by Internet. 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open the ZWSOFT Network License Manager page. 

 

2. Click Return to enter the Return License page, and select Online Return. 

3. Click Return. 
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4. After successful return, it will return to the ZWSOFT Network License Manager page. 

2.2.3.3 Offline Return 

If there's no Internet, you can generate a return request file on your computer first, and then 

send the request file to ZWSOFT Registration Center, or login onto ZWSOFT Products Self-

Service Activation Platform to get the return file. 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open ZWSOFT Network License Manager page. 
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2. Click Return to enter the Return License page, and select Offline Return. 

3. On the offline return wizard page, click Generate and specify a path that you want to 

save the return request file in the pop-up Save as dialog box. 

 

4. Loginhttp://support.zwcad.net:8888/flexnet/operationsportal to obtain a response file. 

(1) Select With Activation ID, input your activation ID, select a language and then click 

Login. 

(2) Click Manage Licenses. 

(3) Select the Fulfillment ID you want to return, and then click Manual Return. 

(4) Import your return request file generated on Step 3, and then click Submit. 

(5) Click Save To File to save your response file. 

5. Click Browse to import your response file obtained on Step 4 in the choose response file 

dialog box, and then click Return. 

http://support.zwcad.net:8888/flexnet/operationsportal
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6. After successful return, it will return to the ZWSOFT Network License Manager page. 

 

2.2.4 Repairing Network License 

In case that the license is destroyed by the unusual situation such as virus infection or special 

hardware changes before returning license, the repair option will be available in the License 

Manager. 

2.2.4.1 Online Repair 

Repair the damaged network license directly via the Internet. 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open the ZWSOFT Network License Manager page. 
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2. Click Repair to enter the Repair License page, and select Online Repair. 

3. Click Repair. 

 

4. After successful repair, click Done to return to the ZWSOFT Network License Manager 

page. 

 

2.2.4.2 Offline Repair 

If the computer cannot connect to the Internet, the network license can be repaired offline. 
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STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open the ZWSOFT Network License Manager page. 

 

2. Click Repair to enter the Repair License page, and select Offline Repair. 

3. On the offline repair wizard page, click Generate and specify a path that you want to 

save the repair request file in the pop-up Save as dialog box. 

 

4. Login http://support.zwcad.net:8888/flexnet/operationsportal to obtain a response file. 

http://support.zwcad.net:8888/flexnet/operationsportal
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(1) Select With Activation ID, input your activation ID, select a language and then click 

Login. 

(2) Click Manage Licenses. 

(3) Select the Fulfillment ID you want to return, and then click Manual Repair. 

(4) Import your repair request file generated on Step 3, and then click Submit. 

(5) Click Save To File to save your response file. 

5. Click Browse to import your response file obtained on Step 4 in the choose response file 

dialog box, and then click Repair. 

 
6. After successful repair, click Done to return to the ZWSOFT Network License Manager 

page. 

 

2.2.4.3 Remove the Damaged License 

You can also directly remove the damaged network license and then reactivate it. 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open the ZWSOFT Network License Manager page. 
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2. Click Remove and prompt "Are you sure to remove the license?". Click Yes to return to 

the ZWSOFT Network License Manager page. 

 

3. Write to support@zwcad.com to contact ZWSOFT to return the damaged license. 

 NOTE 

This step is necessary. Remove the license on the machine, the used node is still 

occupied in the background, if there are no other unused nodes in the activation 

code, the license server cannot be directly reactivated. 

4. Follow the steps to activate the license server again, refer to the help: Activating License 

Server.  

mailto:support@zwcad.com
mk:@MSITStore:C:/Users/Administrator/Documents/WXWork/1688850548317080/Cache/File/2022-07/ZWSOFT%20NLM%20Help(1).chm::/LicenseGuide/html/TS030101.htm
mk:@MSITStore:C:/Users/Administrator/Documents/WXWork/1688850548317080/Cache/File/2022-07/ZWSOFT%20NLM%20Help(1).chm::/LicenseGuide/html/TS030101.htm
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2.2.5 Borrow Manage 

You can to configure which clients are allowed to borrow the licenses, thereby facilitating the 

borrow management of clients. 

The following is an example of steps to configure the clients that are allowed to borrow the 

license on the license server: 

STEPS： 

1. Click Start → All Programs → ZWSOFT Network License Manager → Network License 

Manager to open ZWSOFT Network License Manager page. 

2. Click Borrow Manage to enter the Borrow Manage page. 

 

3. To add a client in the Borrow Whitelist area, click Add. 

 NOTE 
If both the server and the client are using IPv6 address, you need to input 

the client name or its IPv6 address. 
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4. Enter the client name or IP address you want to add in the text box, and click Add. After 

successfully adding, click OK, and click Done. 

You can also click Bulk Import to import client name or IP address from a txt or csv file. 

Example of .txt file:  

computer 1, computer 2, 192.168.100.13, 192.168.100.14 

Example of .csv file: 
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5. The client will be displayed in the whitelist. 

 

6. If you want to add another client, please repeat the steps above. 

NOTE 

1.If whitelist mode is off, all clients are allowed to borrow. Once 

enabled, only clients in whitelist are allowed to borrow. 

2.For any changes to take effect, please launch Network License 

Configuration, and click ReRead License File on Start/Stop/Reread 

tab. 
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3 Basic knowledge 

3.1 Start CADbro 

   Click the CADbro icon from the desktop 

   Or Start-> Program->CADbro 

   The interface below when you first start CADbro 
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3.2 Interface introduction 

1. Function area 

2. File list 

3. Quick toolbar 

4. Manager area 

5. Filter toolbar 

6. File Browser 

7. ViewCube 
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3.3 Open a new file 

File-> Open 

 

3.4 File Browser 

Using the File Browser can quickly locate the directory and add your frequently-used folder to as 

Favorites. 

List windows can list different file formats and quick search the specified file by name. 

1-> Favorites and Recent files 

2-> Disk directory  

3-> File list windows 

 

 

 

 



 

 
42 

Chapter 2 Basic knowledge User Manual 
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4 Manager 

4.1 Part Browser 

Part Browser used to list all the entities belong to the part, like solid, surface, wireframe and so 

on, you can uncheck the checkbox to hide the entity or right-click the folder to erase, hide or show 

all. 

4.2 Assembly manager 

Assembly manager used to manage the whole assembled structure, all the subassembly, 

components can be list here, then right-click on the specified component, more functions will be 

support. 
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4.3 View manager 

View manager used to manage all the view angle, section view, custom view and also the PMI. 
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4.4 Visual manager 

Visual manager used to customize the display status, like open the shadow, switch on/off the 

coordinate or datum plane, setting up the open edge on/off, even the color or thickness.

 

4.5 Export manager 

Export manager support to predefine your exporting configuration, like exporting the file format 

to a specified folder, it can be saved as configuration, after that, you can put the current 3d model 

from graphic window to run this task. 
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5 Convert files 

 

 

Open: Open all the supported files in CADbro, including the Z3D file.  

Import: Import all other files into current Z3D. It will not create a new Z3D file. 

Quick Import: Quick import supports importing a new Z3D file and only showing its display data, 

which is faster than the normal type of import. However, there is no Nurbs data, which means 

that editing this kinds of imported model is limited. 

  

If you want to load the Nurbs data, just click “Load current model” or “Load all model” in the 

right-click menu of the components or the top-assembly. 
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Multi-Import: 

  Multi-Import the third-party format files (ACIS, Catia V4, Catia V5, UG/NX, Proe/Creo, Inventor, 

SolidEdge and Solidworks) and autosave those files to .Z3D files. 

 

Save: Direct save the current Z3D file. 

Save as: Except for saving the current Z3D file, you can save the whole file to any other files. 

 

 

Export: Compare to Save As, Export command support to select specify shape or component 
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from the current file to export. Even can make a filter to include or exclude by Layer, Geometry 

type and Attribute. 

 

Multi-Export: Using the default exporting setting to export files to multiple file formats at one 

time. Users can select the files and objects to export on the Select Object page. 

 

On the Export Settings page, you can specify the destination and select formats to export. 
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6 View 

6.1 View Angle 

Click different View icon to change the view angle 

Align with Plane:  

Click this command then select one plane, the view will change to auto-align this plane 

Align with Direction:  

Define the origin point, Up direction and Right direction to customize the view angle 

How to save the View angle and reuse it later? 

Click the View manager, then right-click the Custom View -> New, then you can save current view 

angle 
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6.2 View 

 

6.3 Visibility 

 

6.4 Display Mode 

 

Analyze:  Display the previous face analyze status 

Combination:  This display mode is used for assemblies when you want to display components 

in different display modes. Like the assembly model below, each component can show in different 

display modes. 

 

Note: To set the different components to different display modes, you can right-click the 

component >Display>then select your needed display mode. 
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6.5 Screen 

Display a multi-window screen, each window size can be dragged to change the size. 

 

    

6.6 Windows 

The list method for all open files. 

 

6.7 Rotation 

Rotate the 3D model around the X/Y/Z axis. Users can also difine a specific axis by Lock any axis 

for rotation 
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7 Selection 

 
Pick control: Control the input field, picking or unpicking. You can also call the pick control by a 

right mouse button click on the graphic window. 

 

 

 

Pick Rule: Control the picking behavior 

 

>Normal Pick is the default picking behavior, which means when you Left mouse click the entity, 

it will auto be selected but the previous picking entity will be removed, you can hold Ctrl key to 

achieve Add picking or unpicking.  

>Add Pick means always add the selected entity to the input field by clicking the left mouse 

button. 

>Del Pick means always remove the selected entity by clicking the left mouse button. 

 

Pick Scope: The window pick behavior, for example, it means all the entity in the windows frame 

will be selected. 
 

Pick from list：When there are multiple legitimate objects under the current mouse position, 

you can switch different object choices through “Pick from list” option from right-click menu. Or 

use the shortcut keys Alt (cannot be released) + right clicking (continuously): traverse and pre-

highlight (pre-selection) the legal objects under the current mouse location and left click the 

mouse when pre-highlight some entity to confirm the current selection. 
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8 Tools 

8.1 Dimension 

New style dimensions can be created by the following tools, which are always parallel to the view 

window. 

The final effect is shown below. 

8.2 Curve creating 

CADbro offers curve creating tools to create the wireframe that includes the Line, Polyline, Circle, 

Rectangle and so on. 
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8.3 Attribute 

 

Line attribute: Use to change the color, style, and width of next creating curve 

 

Face attribute: Use to change the face color, or you can select face set or shape body first then 

click this command 

 

For face attribute, the most often used is the Face color and Transparency 

You can also find the command from the Quick toolbar as below. 

 

 
Material attribute: Use to change the shape or part materials, which allow you to select the 

existed material from the list or add your new material. 
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Part attribute: Use this form to define attributes assigned to the active part. Use this dialog box 

to define properties for active parts, supporting standard attributes, user-defined attributes, and 

physical attributes. 

For Import/Export/Edit in Excel.  
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8.4 Section 

 

 

Planar Section: 

 

Use this command to dynamically section the active part or assembly. Completing this command 

will create section curves in the active part and the active component in an assembly. It can also 

be used as a visual aid to dynamically clip away portions of the part to view features that might 

normally be hidden from view. 

 

The required inputs include the section plane and offset distance. Optional inputs include 

multiple sections (copies at distance intervals) and using the section plane as the first copy. 

 

Section: 

 

Required 

 

This command allows you to set specific characteristics of the section view that is enabled when 

Section View Display Mode is activated.   

  

 

 



 

 

 
58 

User Manual Chapter 8 Tools 

Display control 

 

Sectioned shape - support two buttons, one is the default option to hide the sectioned part, 

another button to show the sectioned part with a wireframe. 

 

Interference - support to specify the interference color. 

 

Hatch color - allow to use part color or specify a color for the hatch. 

 

Hatch style - support three buttons here, the first one is the switch off, the second and third one 

is the different hatch style. 

 

Spacing -is offset value of the hatch style 

 

Opaque -can drag the slider to change the transparency percent of the hatch 

 

Align with section plane- can align the current model to the section plane  

 

Display Interference -Switch on/off the interference checking for the section view 

 

Display section planes -Switch of/off the section plane 

 

Display hatch for non-closed shapes - Whether creating the hatch for the open surface, that’s 

not perfect solid with a gap or missing face 

 

Move handle only - Only moving the dynamic moving handle when dragging, that will not move 

the section plane position. 
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Section Curve 

CADbro supports to display the section curves with extra window, working on the extra window, 

you can rotate the section profile even export it to DWG/DXF/IGES and STEPS. 

 

Insert 

CADbro supports to insert datum and curves into the current model. 

 

Component 

CADbro supports to exclude and include some specified components on the section curves 

window. 

 

 

8.5 Capture 

 

Capture: 

Use this command to capture the active display to a file. It automatically turns off the view extents 

readout, the world axis triad, and the default datum display. You can save to bmp, gif, jpg, and tiff 

graphics file formats. It also allows up to the maximum pixel resolution supported by your graphics 

card 

 

Screenshot:  

 

This command will use window pick to select the area to capture, which can be stored at the 

clipboard so that you can paste to any other application like Word or Excel, what’s more, you can 

save to file or choose a different background color. 
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8.6 Assist 

 

 

Datum Axis 

Use this command to insert a new datum axis. The attributes of the datum axis include one 

orientation, an origin and the length.  

 

Datum 

Use this command to insert a new datum plane, which can be used to create a 3D curve or used 

to be a section plane. 

 

Datum CSYS 
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Use this command to insert a new CSYS, which consists of three axes, three datum planes and 

one origin. 

 

Frame 

Frame can be used to create a local frame, which can be used to recalculate the coordinate 

dimension. 

 

Stock 

Use this command to create an extruded stock feature that completely encloses a single face, an 

entire shape or a block. The required inputs include the shape(s) to enclose and a reference 

plane to orient the stock. By default, the size of the stock equals the extents of the shape. 

 

Hole 

Use this command to create a simple hole in CADbro. 

 

8.7 Mode 

 

 

2D Sheet 

Use this command to go to 2D Sheet environment. 
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9 Analyze 

9.1 Measure 

Measure: 

This command can base on the selected entity to generate the measurement result, which can 

be also recorded and attached in the model and minimize the label. 

Distance: 

This command measures 3D distances at the Part Level. You can measure points, geometry, and 

planes. Remember that you can select more input options. Refer to each method and options 

below. 
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 Angle: 

This command measures 3D angles at the Part Level. You can measure points, geometry, and 

planes. You can select from a variety of different geometry types to measure from. Using the RMB 

(right mouse button) provides even more options to choose from. 

 

 Arc: 

Use this command to select points and display arc data such as radius, included angle, center, and 

normal.  You can use this command to check the radius of a 3D arc, curve or edge as shown in 

the figure or to check the theoretical arc data for three random points.  

 

 Length： 

Use this command to inquire about the length of a line, arc, curve, or edge. You can also inquire 

about a length summation by selecting multiple items to measure. In the sketch, the external 

curves can be captured to inquire. 

 

1) Select a line, arc, curve, or edge to measure. The length appears in the Current Curve 

field.  

2) Select another line, arc, curve, or edge or move. Move the cursor over additional items. 

The new length and total length for each is displayed in the Last Curve and Summation 

fields.  

3) Click OK to close the form.  
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 Area: 

Use this command to inquire about the area of an enclosed planar 3D or 2D region. The following 

information is displayed in the Inquire Area Properties Form (shown below). Refer to the 3D and 

2D procedures below. 

 

 3D Surface: 

Use this command to inquire about an arbitrary 3D planar area enclosed by boundary curves. The 

boundary curves may consist of 3D/2D curves, partial or whole sketch and/or trace profiles, edges 

or curve lists. All boundary geometry must lie on the same plane. 

9.2 Inspect Entity 

 



 

 

 
65 

User Manual Chapter 9 Analyze 

Coordinate: 

Use this command to display the location of a point measured in specific X, Y, Z coordinates. 

 

Curve Info 

Use this command to inquire curve information on any line, arc, curve, or edge. 

 

 NURBS data 

Use this command to inquire the NURBS data of a line, arc, curve, or edge. 

 

Control Polygon 

Use this command to display the control polygon of a curve. This 

refers to the line segments that connect adjacent control points of 

a curve. The control points are the set of points that are saved by 

the system and used mathematically to define the curve. You can 

apply this command to the active part to another component in an 

assembly or sub-assembly from the active part.  

 

 

Curvature Plot 

Use this command to display the curvature plot of curves or edges. The plot is displayed as line 

segments projecting out perpendicular from the curves. The length of each line segment 

illustrates curvature at that point on the curve. This command helps to visualize overall curvature 

across a curve or edge. 

 

Param Space Partition 

Use this command to display the parameter space of a curve. Point markers at each point on a 

curve associated with a knot value are displayed along with the normalized parameter and arc 

length values at each point.  

This helps you determine how close the curve is to arc-length parameterization. This echo relates 

to the existing curve. Use the Cubic Refit Curves command to echo this information for a resulting 

refitted curve. You can apply this command from the active part to another component in an 

assembly or sub-assembly. 

 

 Analyze Faces 

Use this command to analyze faces for surface imperfections, draft angles, curvature, and other 

mk:@MSITStore:D:/Program%20Files/ZWSOFT/ZW3D%202016%20Eng%20(x64)/doc/ZW3D.CHM::/articles/article-360.html
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surface characteristics. The analysis results are presented in a variety of plots superimposed on 

the active part. This command switches the Graphics Window to Analyze display mode and leaves 

it in that mode when the command terminates. Use the View menu or the Toolbar's display mode 

button to switch to another display mode when the analysis results are no longer needed.  

 

Surface curvature 

Use this command to inquire about the curvature of a face where it passes through a specified 

point. By default, the point lies on the face. You can use the Face option to select a different face 

to analyze. By default, a direction that is normal to the face through the specified point is used to 

"slice" the face for curvature analysis.  You can also select a different direction if desired. 

 

Continuity Error 

Use this command to analyze the tangent continuity across two mating faces at a selected edge. 

The edge must be shared by both faces. The results displayed are the maximum and average error 

measured in degrees. You can also check for C0 continuity (gaps) along the edge by selecting 

Position from the Continuity option. 

 

 

9.3 Inspect Model 

 

 

 Mass Properties 

Use this command to calculate and display mass properties information (e.g., volume, area, mass, 

etc.) for a selected shape (open or closed), component, or the entire assembly. Blanked and/or 

suppressed components in an assembly will be ignored during these calculations. (Surface) The 

area is the only value that can reasonably be relied on for an Open Shape. A warning message is 

prominently displayed letting you know that you have selected an Open Shape. 

 

 Part Interference Check 

To clearly understand the interference between shapes, user can use this command to check the 

interference status between shapes. 
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10 PMI 

10.1 Manager 

After creating PMI notes, you can go to the View manager as below to activate different views to 

create PMI, move or copy PMI from one view to another view, what’s more, you can control the 

PMI visibility by using the manager. 

10.2 Dimension 

Use to create different 3d dimension types as below. 
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10.3 Annotation 

Use to add different 3D annotations on the model. 

 

10.4 Text 

Simple text and the text with balloon 

 

10.5 Tools 

PMI Dimension 

 

This command is used to preset all PMI attributes, including the dimension style, text style. etc. 
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 Resize PMI 

 

When creating a PMI note, it will generate a different note sizes base on a different view, this 

command can reset the global PMI size to match all notes. 

 

 Regen PMI 

This command uses to do regeneration for PMI, if you want the PMI to be refresh or update, you 

can use this command to do that
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11 Healing 

11.1 Checking 

Heal/Analyze 

This command analyzes and attempts to repair abnormal conditions relating to the geometry of 

entities (e.g., vertex points, edge curves, UV curves, face boundaries - refer to the figures above) 

that defines the topology of the active part. Such conditions include gaps between face edges and 

coincident vertices. 

Show Open Edges 

Use this command can quick check the open edges one by one. Use the arrow button you can 

jump to previous or next one, use Zoom to the window will zoom to the current open edge to 

display. 

 Check Edge 

This command checks and/or delete tiny edges whose curve lengths are smaller than a specified 
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tolerance and that are not required to define the topology of the active part. This command will 

attempt to bring the encountered conditions within the current Geometry Tolerance setting. 

Select the edges to check/delete or middle-click for all edges. 

 

Fit Plane 

Use this command to check and fix planar faces.  

 

11.2 Healing 

 

Sew 

Sew the open edge face to be merge one. 

 

 Explode 

Explode the selected face set to be multiple faces. 

 

Sew Edge’s Gap 

This command attempts to sew a gap that exists between two sets of face edges. After selecting 

the two sets of edges, CADbro will extend the two faces to try to determine curves of intersection. 

If intersections are found, the faces are trimmed to the new intersection curve which then 

becomes the new shared edges. If multiple edges are selected for each set, it is best that they 

form a closed loop.  

If the faces will not intersect when extended, then a medial curve located between the edges is 

projected onto each face and then each face is trimmed. This will not close the gap but will make 

the two edges more closely aligned with each other. This operation is limited to working on open 

faces. Therefore, you must first explore the faces and then sew them. Refer to the optional Edge 

Cv input below.  

You can also select two sets of edge curves. A checkbox is provided to enable this option.  

 

mk:@MSITStore:D:/Program%20Files/ZWSOFT/ZW3D%202016%20Eng%20(x64)/doc/ZW3D.CHM::/articles/article-228.html
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Close Gaps 

This command is designed mainly to handle imported geometry to attempt to sew gaps that exist 

between shared face edges. After selecting the edges, CADbro will extend the faces to try to 

determine curves of intersection. If intersections are found, the faces are trimmed to the new 

intersection curves which then become the new shared edges. If multiple edges are selected, it is 

best that they form one or more closed loops. 

If the faces will not intersect when extended, then a medial curve located between the edges is 

projected onto each face and then each face is trimmed. This will not close the gap but will make 

the two edges more closely aligned with each other. This operation is limited to working on 

imported open faces. Therefore, do not sew the faces before using this command. 

 

Fill Gap 

This command fills open gaps between faces. The gaps must be bordered by a closed loop of open 

edges. If the edges are not coplanar, a ruled face is created. If the edges are coplanar, a planar 

face with trim loops is created. 

 

Reverse Direction 

Use this command to reverse the normal direction of faces or shapes. Direction arrows will appear 

indicating the current direction of the face or shape. 

mk:@MSITStore:D:/Program%20Files/ZWSOFT/ZW3D%202016%20Eng%20(x64)/doc/ZW3D.CHM::/articles/article-248.html
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12 Edit 

12.1 Direct Edit 

DE Move 

Use these commands to move face. Various methods are supported including directions, points, 

and frames. 

Align Move Face 

Use this command to align move face by using 3D constraints. The constraints include coplanar, 

concentric, tangent, parallel, perpendicular, at angle and symmetric. 

• Motion face

Select a face to move.

• Stationary

Select a stationary object. The motion face will keep the specified constraint with this

object. 

• Angle

This field is available if the constraint is At angle. Set the angle between the motion face

and the stationary object. 

• Symmetry plane

This field is available if the constraint is Symmetric. Specify the symmetry plane

between the motion face and the stationary object. 
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 Dim Move Face 

 

Move face by dimension, which supports linear and angular dimensions. 

 

 DE Face offset 

 

Use this command to offset one or more faces of a shell. This command extends or trims faces 

as needed during the offset operation to close gaps and resolve intersections.  

 

 DE Draft 

 

This command creates a draft feature about selected faces. 

 

 DE Copy 

 

Use these commands to copy face. Various methods are supported including directions, points, 

and frames. 

 

 

 DE Mirror 

 

Use this command to mirror the selected faces. 

 

 DE Pattern 

 

Use this command to pattern the selected face.  
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 Modify Fillets 

 

Use this command to modify the selected fillet.  

 

 Modify Radius 

 

Use this command to modify the radius of cylinder and sphere。 

 

 Modify Holes 

 

Use this command to modify the hole without re-generation history. 

 

Replace 

 

Use this command to replace one or more faces of a solid or shape with another face or shape 

or datum plane. 

 

 Simplify 

 

Use this command to simplify a part by removing selected faces. The command will attempt to 

extend and reconnect faces to close the resulting gaps in the part. If the part cannot be closed 

properly an error message will be returned. Select the faces to remove and then middle-click to 

remove them. 

  

Alternately, you can also delete or blank the features that contain the faces.  
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12.2 Shape transform 

 

Shape transform commands support to move, copy mirror and scale the selected shapes. 

 

12.3 Part transform 

 
Part transform commands support to move, drag, mirror and rotate the selected component. 

Compare to shape transform, the target entity type is different. One for shapes, one for 

components. 
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13 Mark up 

  Create new comment 

Create a new comment will list on the manager as below 

 

 

Right-click the comment you will see the list below, you can change the setting, save the comment 

to Z3DM file, rename or erase it. 

 

 Setting 

 

With setting command, you can add more information for the comment, even change the font 

style like text font, line thickness, and color. 
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Apply changes to:  

 

All comment in this environment：Will change all comments 

Current comment: Only affect the current comment, this option only available when you right-

click a comment and use the setting. 

New comments: Will affect the new creating comment, but not the existed comments. 

 

 Open markup 

 

Open the saving comment file, which is Z3DM file. 

 

 Save markup 

 

Save all comments or select one of them to save. 

 

 Text with leader 

 

Create the label text with a leader. 
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 Text 

 

Only create the text without a leader 

 

 Image 

 

Insert the extra image. 

 

 Linear dimension 

 

Create the linear dimension as below 

 

 

 Angular dimension 

 

Create the angular dimension as below. 



    

 

 
80 

User Manual Chapter 13 Pro 

 

 

 Stamp 

 

Insert the stamp to the screen 
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14 Pro  

14.1 Assembly 

CADbro provides many tools to work with components within an assembly. You can check for 

interference, blank a component or inquire component properties. You can also set the regen 

status of each component individually and clone parts. Refer to the topics below. 

Interference Check 

Use this command to check the interference between components. Please note that the 

suppressed components in an assembly will be ignored during these calculations. The following 

steps show how to use this command. 

Step 1: Select the component to be checked. If you leave it blank, the whole assembly will be 

checked.  

Step 2: Define the check scope and other options according to the needs. 

Step 3: Click “Check” button to calculate, and the results will be listed in the dialog.  

Below are the explanations of the options of this command. 

Scope Options 
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➢ Only among the picked 

Only check the interference among the selected components.  

➢ With other components 

Check the interference among the seleted components, and meanwhile, check the 

interference among the selected components and other components.  

 

Other Options 

➢ Include shapes within the assembly 

Check this option, the interference between the picked components and shapes will be 

checked. 

➢ Check among shapes 

Check this option, the interference among all the shapes will be checked. 

➢ Treat subassembly as a whole 

Check this option, the interference between the subassemblies will not be checked. 

Note: This option is only available when the selected components contain subassemblies. 

➢ Ignore hidden shapes and components 

Check this option, the hidden parts and components will be ingnored. 

➢ Save interference geometry 

Check this option, you can save the interference shapes in the history list. 

➢ Non-interfering components 

This option is to define the display mode of the non-associated components, including 

“Hidden”, “Transparent”, “Shade” and “Wireframe” modes. 
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Clearance Check 

Use this command to check the clearance among components. The following steps show how to 

use this command. 

Step1: Select the components to be checked. If you leave it blank, the whole assembly will be 

checked. 

Step2: Set the clearance value. 

Step3: Define the scope of clearance check. 

Step4: Click “Check” button to get the results. 

 

There will be 3 possible results: 

 Contact: The distance between the components is 0mm. 

 Interference: There is interference between the selected components.  

 Distance value: The distance between the components is more than 0mm but less than the 

pre-set clearance value. 

Below are the explanations of the options of this command. 

➢ Check clearance between components and shapes 

Check this option, and the clearance between the picked components and shapes will be checked. 

➢ Check sub-assembly internal parts clearance 

Check this option, and the clearance between the parts in the sub-assembly will also be checked. 

➢ Ignore hidden shapes and components 

Check this option, and the hidden parts and components will be ignored. 

➢ Unrelated components 

This option is the same as the “Non-interfering components” option in the “Interference Check” 

command. 

➢ Output check results 

Click this button to export all clearance results to an Excel sheet.  

 



    

 

 
84 

User Manual Chapter 15 HelpDesk 

 Compare Parts 

 

Use this command to compare two parts and show the differences between them. CADbro 

provides two methods for comparison, solid compare and face compare  

This command support to select the Z3D file from local disk without opening in CADbro. 

 

Solid Compare  

Select the part file as below, then click the Calculate button. 

 
Below is the compare result, which shows the different regions, you can also change the color 

and the transparency and hide the regions. 
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Reset: Reset all the settings for display, color, and transparency. 

Save file: Save the comparison result as Z3D or other neutral formats.  

Save report: Generate a comparison report. 
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Face compare 

Select the part file as below, then click the Calculate button. 

 

Below is the calculating result, which shows the unchanged faces, changed faces and unique faces, 

you can also change the transparency and hide the faces. 

 

Click the Save button to generate the compare report. 
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 Exploded View 

 

Use this command to create exploded views for each assembly configuration. This command 

provides a list to record every explosion step, in which you can re-order the existing steps by drag-

dropping the picked step. 

 Add Exploded Step 

CADbro added “Move exploded” “Rotate exploded” and “Radial exploded” in “Add Exploded 

Step” command to meet user’s requirement of more complex exploded view including 

complicated path, display path and entirely exploded of sub-assembly.  

Meanwhile, CADbro added “Record moving turn point” and “Add trails” to enrich the exploded 

path. Besides, the option of “Select subassembly part” has achieved different exploded needs. 

 

Check “Record moving turn point” to record the current position, and then perform exploded 

steps in other directions. The final one will be a complex and continuously multiple exploded 

paths. 
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Check “Select subassembly part” to explode the entire subassembly of the currently selected 

object, which can satisfy the request of the whole assembly explosion and finally get the designed 

explosion result.  
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Check “Add trails” option to record exploded trail with double dots line while creating an 

exploded view. 

 

 Auto Explode 

We added “Auto Explode” to increase the efficiency of creating exploded view, which achieves to 

create batch component exploded view in uniform. The options “Explode subassembly part” and 

“Add trails” can achieve different exploded needs. 
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Add Exploded Trail 

To solve the problem that user did not record exploded trial and continued to add exploded trial 

in follow-up, CADbro can manually add exploded trial in exploded view through defining start and 

end position so to reach exploded trail creation. 

  

If the option “Along XYZ” is checked, the created trail shall be along the axis of the orthogonal. 
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 Auto Exploded Trail 

Used “Auto Exploded Trail” command to improve the efficiency of exploded trail creating. In 

addition to batch create exploded trails, the function also provides the method to select the start 

and end of the trial, which achieves the addition to different exploded trails.  

• The trail can set the bounding box center. 

• The trail can set the component origin. 

 
 

 Reuse Exploded View 

Use “Reuse Exploded View” command to raise the efficiency of multiple exploded view. The 

created exploded view should be applied in the current exploded view, which meet the combined 

application of complex exploded view. 

If the option “Add trails” is checked, the reused exploded view will carry with the exploded trails.  
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 Exploded View Video 

 

Use this command to convert the picked exploded view from the lists to generate an AVI video. 

 

 

 3D BOM 

 

Use this command to generate BOM table of all components of the assembly parts. 

⚫ Level Display Settings  

Top-level only: Select this item to display only the top-level components.  

Parts only: Select this item to display only parts.  

Indented: Select this item and indent it by assembly level. 

Shape only: Select this item to display only the shapes.  

⚫ Include shape & Update calculated attributes  

Include shape: Click on the "Include shape" button, and the 3D BOM will display the shape 

information.  

Update calculated attributes: Click on this button, update all the calculated attributes in the 3D 

BOM table.  

⚫ Search Function  

Select an attribute and enter the required value to search the corresponding content in the 3D 

BOM table.  

Exact search: When using exact search, only the component information which coincides with t

he search content will be displayed as the search results. After entering the content to be search

ed but not clicking the button to start, the component information containing the search conten

t will be highlighted.  

Filter search result: Display the search results according to the preset filtering conditions. 
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⚫ Export Data  

Export format: The current form of 3D BOM is output as a template, and the template is saved 

as .Z3DBOMTT format.  

Export data: Export the current 3D BOM content to EXCEL.   

⚫ Column   

All the optional attributes of the 3D BOM are displayed in the column tab, including system 

attributes and user attributes.  

Attribute: Attribute is the corresponding name in the system and can not be modified.  

Descriptive Name: The descriptive name is the corresponding name in 3D BOM and can be 

modified.  

Include: Check the checkbox and the selected attributes will be displayed in the 3D BOM.  

Total: Check the checkbox and the selected attributes will display total row in 3D BOM.  

Add user attribute: Users can add user attributes whose types include string, Boolean, integer, 

numbers, and date.  
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14.2 Mold 

 

 Align 

 

This feature is used to realign geometry after data is imported. Click to enter the interface. 

 

 Shrink 

 

This command is used to define a product's shrinkage. 

 

 Region 

 

The command according to the regularity of mold structure can quickly review all the surface 

properties of the model. In Auto Define, selecting a product model and determine the opening 

mold direction (default is z-axis). System will automatically analyze and get different colors 

according to different parts of a mold, which distinguishes between core and cavity easily. System 

goes into Manual Define when completing automatically. Users can view the analysis results 

under regional options. In this interface, users can change their mold structure to satisfy the 

design needs so as to provide basis for future mold design. The core and cavity areas have been 

defined when the Undefined Faces show zero. 

 

  Project Silhouette to Plane 

 

Use this command to project the shape silhouette to a plane. You can control to display the outer 

loop of silhouette only or all curves of it.  
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 Project Shape to Plane 

Use this command to project the shape silhouette to a plane, and the result is face. You can control 

to display the outer loop of silhouette only or all loops of it.  

 

 

 

 Draft 

 

Use this command to analyze faces for surface imperfections, draft angles, curvature, and other 
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surface characteristics. (See Chapter 5.2 Inspect Entity-> Analyze Faces) 

 

Thickness Analysis 

 

Use this command to analyze the thickness of parts and help users to estimate whether the design 

is correct. 

 

 Undercut Analysis 

 

Use this command to analyze whether there are any undercut faces in the model. It can assist 

users to estimate where to set sliders or other systems. Besides, it can also help users to select 

appropriate operation and clamping method, in order to create a complete tool path for 

machining. After defining the detect direction (parting direction or cutter axis direction), CADbro 

will automatically color the whole part. 

Tips: 

• For mold analysis, it should check on the “include negative direction”. 

• For CAM analysis, it should not check on the “include negative direction”. 

 

 Height Analysis 

 

Use this command to detect all the plane parallel to a specified datum, and list them in the table. 

It is easy for the user to find out the important plane and calculates the plane numbers. 

Tips: 

Height analysis cannot be used in assembly. 

 

 Height Analysis Result 

 

This command is used to record the result of the last time Height analysis. In this mode, the user 

can view the part with colors, and add PMI or annotation in those faces. 

Tips: 

Before Height Analysis, the command will be gray out. 
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15 HelpDesk 

 

 

 User Folder Manager 

 

Use this command to manager the user folder. In this command, user can clear “auto output files”, 

“custom configurations”, “template files” or “user folder” .If user want to save/load configuration,  

please click “Save current configurations” or “Load backup configurations”. 

 

 

 About 

Use this command to check the information about CADbro. In this page, you can view the Version, 

VERNUM, OS Version, Graphics Card , OpenGL Version, User Folder, Program Folder and license 

information. 
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 Video Learning 

Use this command to link to the CADbro video learning website. 

 

 Mail 

Use this command to sent a email to CADbro service team. 

 

 Report Bug 

Use this command to report errors to CADbro service team. When using this function to send 

reports, the system automatically sends files and computer system information to the CADbro 

service team.
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16 2D Drawing 

Using the 2D Sheet command from tool ribbon 

 

 

CADbro can automatically generate a 2D view as below. Location, projection angle and different 

layouts can be changed. 

 

Working with 2D Drawing, you can create a simple dimension and draw 2D entities manually. 

 

 

 

 Standard View 

 

Use Standard View to create a standard orthographic layout view from a 3D part. Steps are as 

below: 



    

 

 
100 

User Manual Chapter 16 2D Drawing 

Step1: Pick the Standard View command. 

Step2: Select the object from a file. 

Step3: Pick a view type. 

Step4: Set the detailed parameters like scale and label. 

Step5: Place the standard view on the work area. 

 

 



    

 

 
101 

User Manual Chapter 16 2D Drawing 

 Projection View 

 

Use Projection View to create a view projected from another existing 3D layout view. Steps are as 

below: 

Step1: Pick the Projection View command. 

Step2: Select an existing view to generate the projection view. 

Step3: Set the detailed parameters. 

Step4: Place the projection view on the work area. 
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 Auxiliary View 

 

Use Auxiliary View to create an auxiliary view that is projected perpendicular from an edge of 

another layout view (referred to as the base view). Steps are as below: 

Step1: Pick the Auxiliary view command. 

Step2: Select an existing view to generate and choose a line for alignment. 

Step3: Place the Auxiliary view on the work area. 
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 Full Section View 

 

Use Full Section View to create a fully sectioned views base on a 3D layout view. Steps are as 

below: 

Step1: Pick the Full Section view command. 

Step2: Select an existing view to generate the section view. 

Step3: Define the section line. 

Step4: Place the section view on the work area. 
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 Detail View 

 

Use Detail View to create circular and rectangular detail views from another 3D layout view. 

Step1: Pick the Detail View command. 

Step2: Select an existing view to generate a detail view. 

Step3: Define the area you want to zoom in on. 

Step4: Place the detail view on the work area. 

Step5: Set the detailed parameters. 
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 Crop View 

 

Use Crop View to create a partial view by trimming a drawing view with a defined boundary.  

 

Step1: Pick the Crop View command. 

Step2: Select the crop type and pick an existing view to generate the crop view and define the 

boundary. 
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17 Cloud service 

17.1 Create a cloud service account 

Before using cloud service, you need to sign up an account for CADbro cloud service. Please 

follow the below steps to create a CADbro could service account. 

1) Go to CADbro Cloud website (https://cloud.cadbrother.com/v3/login).

2) Click “Sign up” in the upper-right corner.

3) Input your country/region, email address, verification code and password.

4) Click “Sign up” and then the system will send you a verification mail.

5) Login your mailbox to finish the account verification.

17.2 Personal space management 

CADbro Cloud will give each user an online storage space of 100 Mb capacity for free to 

experience the cloud service. And users can check the basic information (capacity and personal 

setting) and manage the uploaded files. 

https://cloud.cadbrother.com/v3/login
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17.3 Team space management 

After creating a CADbro cloud service account, we can create a team with cloud service license 

to manage the files by projects and start project collaboration. 

17.3.1 Create a team 

To create teams, you need to purchase a cloud service license. Creation procedure is as below: 

1) Click “Create” in the upper-left corner.

2) Input your team name, cloud service license, and team description.

3) Click “Submit” to finish.
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Notice: When the team is created successfully, the account creating it will become the super 

manager of the team. The super manager will have the permission to: 

• change team settings such as the team name, description and reset the team 

• invite members to join the team or remove members from the team 

• create projects 

• assign roles (manager, member and visitor) to members 

• manage all the files in the projects 

17.3.2 Invite members to a team 

There are two methods for super manager to invite members to join the team. 

Email: Send an invitation email to members. The members who are invited need to accept the    

     invitation via email. 

URL: Generate invitation urls in CADbro cloud and send to the members to be invited. The  

    invited members need to load the URL for acceptance. 
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17.3.3 Create a project 

The super manager can create projects, assign roles to members, distribute storage capacity 

and share links of projects. In team collaboration, model files can only be stored in projects. 

 

 

17.3.4 Add members to a project 

Super manager or manager can add members to a project. 
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17.3.5 User roles 

Super manager or manager can assign different user roles to project members. 

Manager has the permission to change project settings, and manage members and files in 

projects, including uploading/updating models, creating share links for models, and viewing 

models. 

Member has the permission to upload/update models, create share links for models, and view 

models. 

Visitor is only allowed to view models. 

 

17.3.6 File management 

After creating projects and assigning user roles, super manager, project manager and member 

can view, share, delete and restore files via web or client. 

Note: Uploading is only supported in desktop client currently. 
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➢ File share 

Steps for creating a share link. 

1) Click  icon near the file to be shared.  

2) Set the sharing options, such as expiry date, password, view times and so on. 

 

3) Click “Submit” to finish. 

➢ Management of shared files 

In Shares tab, users can copy share link and password (if there is), modify the share 

options, cancel sharing, and view the current usage of the shared files. 
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➢ Sharing methods 

You can share files via links or QR codes. 

 
➢ File history 

Click  icon to invoke the History list which records all the operations on the current files, e.g. 

create, edit and update to a newer version. 

 

➢ Delete/Restore files 

Click  icon to delete any files in the project. The deleted files will be stored in the Recycle Bin 

temporarily. Users can restore the file or delete them permanently. 
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17.4 Collaboration 

Members in the same project can use collaboration function in the CADbro to share the views, 

annotations and chat in real time. Starting the collaboration session requires you to login CADbro 

Cloud and upload a file first.  

17.4.1 Login CADbro  

   Steps for logging in CADbro Cloud in desktop client 

1) Launch CADbro. 

2) Go to the “Start” toolbar, and click Login command. 

3) Input your account and password to login. 

 

17.4.2 Upload models 

Open the file in CADbro, click Upload File command and select a project it will be uploaded to.  

Note: CADbro will convert the model into light-weight format (.z3ds) and upload it to the Cloud 

server. 
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17.4.3 Start collaboration 

Steps for starting collaboration: 

1) Choose a model from a project and right-click it. 

2) Select “Collaboration”. 

 

3) Input a name for the collaboration. 

4) Select members to join the collaboration  

5) Describe the collaboration if needed. 

6) Click “OK” to start the collaboration 
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17.4.4 Operations in collaboration 

In collaboration, users are allowed to share views, annotations and chat in real time. 

 

1) Add Members   

Click this icon to add new members to the current collaboration. 

 

2) Sync Switch  &  

Click these icons to pause/continue the Sync. 
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3) Part State Share   

Click this icon to show the current state of the part to newly-joined members. 

4) Leave Collaboration   

Click this icon to leave the current collaboration. 

Note: The controller must hand over the controller right to another member before successfully 

leaving the current collaboration.  

 

17.4.5 Playback 

System will record all the operations during the collaboration and save them to the 

collaboration folder. A playback record will be helpful to the ones who didn’t attend the 

collaboration or the ones who want to review the collaboration process. Below are steps to 

review the playback record. 

Step1: Find the target collaboration in Space > Collaboration. 

Step2: Right-click the collaboration and click “Entry” to enter the playback environment.  

Step3: Review the playback record. There are many options for users’ better experience. 

 

 

17.4.6 View 3D models in browser 

By loading the share links, users can open models in a web browser. They can:  

• View 3D models  

• Check assembly structures 

• Show or hide components 

• Check explosive view 

• View by sections  
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• Measure 

• Move components 

• …… 

     
And if there is pre-defined exploded view in ZW3D or CADbro desktop version, you can view it in the 

browser as below: 
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18 Filter 

Filter is important to control the select entity from the graphic window. 

 

The pick filter list shows the entity types that the active command prompt is looking for. The list is 

displayed when the pick filter icon is selected (see above) of when (Shift) key and the right mouse 

button (RMB) are selected together. When you select an entity type from the list, only those entities 

can be selected or highlighted. You can pick the Attributes button (when displayed) to filter by 

additional attributes. 

 

Holding the Shift key + Right mouse button, the filter list will display on your mouse pointer position. 
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19 Interface customization 

You can right mouse button click on the ribbon empty area, then you can see interface you 

customization command. Or can directly click the Customize… command from the Ribbon tab. 

 

 
 

What you can customize?  

You can add your own command. 

 
Transfer the command between different ribbon tab, you can also create a new ribbon tab. 
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Customize the hotkey for CADbro. 

 
Customize your mouse action, with this function below, you can customize CADbro mouse 
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actions to be the same as other 3D systems, this will make you easy to get used to working 

with CADbro. 
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20 Changing language 

Click the Windows button, find the ZWSOFT folder and click the button Change Language. 

 

 

 

Then you can choose one to change the installation language 
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21 Online update 

Click Windows button, find the ZWSOFT folder and click the button Check For updates.  
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22 Set File associations 

Click Windows button, find the ZWSOFT folder and click the button Set File Associations. 

  

Use this command you can set the formats to link with CADbro. When you double click on the 

format then it will default to open in CAD bro. 
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